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Cronologia delle revisioni
Versione
del
prodotto

Istruzioni di
funzionamento

Modifiche Commenti

2.09.xx BA00065S/04/IT/01.12 – Istruzioni di funzionamento originali

2.09.xx BA00065S/04/IT/02.13 Nuova WirelessHART, scheda NI, modem
FFusb; modem bluetooth MACTek,
installazione DTM, aggiornamento
catalogo DTM, sostituzione iDTM

Editoriale Procedura di installazione USB in
Windows 7

Layout Nuovo CD

2.10.xx BA00065S/04/IT/03.15 Layout Nuovo CMS

Nuova HART tramite ControlLogix di Rockwell
Automation, PROFIBUS PA tramite
ControlLogix di Rockwell Automation,
ruoli utente, controllo della rete

2.10.xx BA00065S/04/IT/04.15 Nuovi capitoli e
modifiche

HART tramite RSG45, Fieldgate SFG500
e Siemens ET200M/iSP, PROFIBUS DP
tramite modem PROFIBUS e I/O remoto
WAGO, PROFIBUS DP tramite ProfiCore
di PROCENTEC, vista di impianto,
informazioni sugli errori SFG500

2.11.xx BA00065S/04/IT/05.16 Nuovi capitoli e
modifiche

Introduzione a FieldCare, I/O remoti
LB/FB di Pepperl+Fuchs, HIMA,
gateway PROFINET - PROFIBUS, PBI-
PLUS, Heartbeat Verification, reti I/O
Link, interfaccia a W@M

2.11.xx BA00065S/04/IT/06.17 Documentazione
separata in "istruzioni di
funzionamento" e
"documentazione
speciale"

Tutorial per progetti FieldCare
SD01928S/04/EN

2.12.xx BA00065S/04/IT/07.17 Nuova versione del
prodotto
Modifiche alla sezione
"Funzionamento"

-

2.13.xx BA00065S/04/IT/08.18 Nuova versione del
prodotto

-

2.13.xx BA00065S/04/IT/09.18 Modifiche Eliminazione argomento I/O-Link

2.14.xx BA00065S/04/IT/10.19 Nuova versione del
prodotto

IO-Link

2.15.xx BA00065S/04/IT/11.20 Nuova versione del
prodotto

Chiavetta USB anziché DVD
Sistema di gestione delle licenze
software (SLM)

2.17.xx BA00065S/04/IT/12.22 Nuova versione del
prodotto

Supporto FDI Package
Aggiornamento di protezione
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1  Informazioni su questo documento

1.1  Scopo della documentazione
Le presenti Istruzioni di funzionamento forniscono tutte le informazioni richieste per
l'utilizzo del software: dalla descrizione, l'installazione e l'uso del prodotto all'integrazione
nel sistema, il funzionamento, la diagnosi e la risoluzione dei problemi, inclusi gli
aggiornamenti del software e lo smaltimento.

1.2  Simboli

1.2.1  Simboli di sicurezza

Simbolo Significato

PERICOLO

PERICOLO!
Questo simbolo segnala una situazione pericolosa, che causa lesioni gravi o mortali se
non evitata.

AVVERTENZA

AVVISO!
Questo simbolo segnala una situazione pericolosa, che causa lesioni gravi o mortali se
non evitata.

ATTENZIONE

ATTENZIONE!
Questo simbolo segnala una situazione pericolosa che può causare lesioni minori o di
media entità se non evitata.

AVVISO

NOTA!
Questo simbolo contiene informazioni su procedure e altri fatti che non provocano
lesioni personali.

1.2.2  Simboli per alcuni tipi di informazioni

Simbolo Significato

Consentito
Procedure, processi o interventi consentiti.

Preferito
Procedure, processi o interventi preferenziali.

Vietato
Procedure, processi o interventi vietati.

Suggerimento
Indica informazioni addizionali.

Riferimento che rimanda alla documentazione

A Riferimento alla pagina

Riferimento alla figura

Avviso o singolo passaggio da rispettare

1. , 2. , 3.… Serie di passaggi

Risultato di un passaggio

Aiuto in caso di problema

Ispezione visiva
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1.2.3  FieldCare Simboli

Simbolo Significato

Avvio di un nuovo progetto.

Apertura di un progetto esistente.

Salvataggio di un progetto aperto.

Stampa di un progetto aperto.

Apertura degli appunti.

Visualizzazione del catalogo DTM.

Apertura della documentazione del dispositivo selezionato o accesso a informazioni dettagliate sul
dispositivo.

Apertura dell'inventario.

Attivazione del protocollo.

Aggiunta di un nuovo dispositivo alla rete.

Rimozione di un dispositivo dalla rete.

Creazione di una nuova topologia di rete utilizzando CommDTM e DeviceDTM.

Confronto sul posto della topologia di rete con la rete fisica effettiva e aggiunta di dispositivi alla rete
esistente.

Scansione della topologia preconfigurata e visualizzazione del report con le informazioni sui
dispositivi scansionati.

Indicazione dell'esistenza di una connessione con il dispositivo.

Trasferimento di informazioni dal dispositivo a FieldCare.

Trasferimento di informazioni da FieldCare al dispositivo.

Funzioni specifiche del dispositivo selezionato.

Aggiunta del livello impianto.

Aggiunta di un elemento.

Rimozione del livello impianto.

Rimozione di un elemento.

Apertura della checklist dei dispositivi per visualizzare i dispositivi selezionati nell'impianto.

Conferma del dispositivo sostituito.

Scollegato.  1)
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Simbolo Significato

Configurazione della comunicazione, pronto per la comunicazione.  1)

Canale di comunicazione occupato o azione di comunicazione annullata. 1)

Collegato.  1)

Simbolo W@M, viene visualizzato nella barra di avvio in basso a destra se è stata stabilita una
connessione a W@M.

Attivazione della modalità touch.

Disattivazione della modalità touch.

1) Indicatore di stato: indicazione dello stato online/offline dei dispositivi nell'impianto e nella vista di rete

1.3  Testi in evidenza

Evidenziazione Significato Esempio

Grassetto Tasti, pulsanti, icone di programma, schede,
menu, comandi

Start → Programs → Endress+Hauser
Nel menu File, selezionare l'opzione Print.

Parentesi angolari Variabili <unità DVD>

1.4  Acronimi utilizzati

Acronimi Significato

APL Advanced Physical Layer

CSV Comma Separated Value (valore separato da virgole)

DTM Device Type Manager (driver dei dispositivi)

FDI Field Device Integration

FDT Field Device Tool

HART Highway Addressable Remote Transducer

I/O Ingresso/uscita

IO-Link Nome commerciale di un sistema di comunicazione comprendente sensori e attuatori intelligenti

IODD Descrizione dispositivi elettronici (IO Device Description)

IP Protocollo Internet

PROFIBUS Bus di campo di processo

PROFINET Process Field Network

SLM Software License Management (sistema di gestione delle licenze software)

TCP Transmission Control Protocol (protocollo di controllo della trasmissione)

UDP User Datagram Protocol

URL Uniform Resource Locator (sequenza che identifica l'indirizzo di una risorsa)

W@M Web Enabled Asset Management



FieldCare SFE500 Informazioni su questo documento

Endress+Hauser 7

1.5  Documentazione
FieldCare SFE500
• Istruzioni di start-up KA01303S/04/A2
• Tutorial per progetti FieldCare SD01928S/04/EN
• Informazioni tecniche TI00028S/04/EN

1.6  Marchi registrati
PROFINET® è un marchio registrato di PROFIBUS Nutzorganisation e.V. (organizzazione
degli utenti PROFIBUS), Karlsruhe/Germania.

PROFIBUS® è un marchio registrato di PROFIBUS Nutzorganisation e.V. (organizzazione
degli utenti PROFIBUS), Karlsruhe/Germania.

IO-Link® è un marchio registrato di IO-Link Consortium/IO-Link Community c/o
PROFIBUS Nutzerorganisation e.V. (PNO) Karlsruhe/Germania

FOUNDATIONTM Fieldbus è un marchio commerciale del FieldComm Group, Austin, TX
78759, Stati Uniti.

HART®, WirelessHART® è un marchio registrato del FieldComm Group, Austin, TX 78759,
Stati Uniti.

Ethernet/IP è il marchio commerciale di ODVA, Michigan, Stati Uniti.

Modbus® è un marchio registrato della Modbus Organization, Hopkinton, Stati Uniti

Tutti gli altri nomi di marche e prodotti sono marchi o marchi registrati delle relative
aziende e organizzazioni.
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2  Istruzioni di sicurezza generali

2.1  Requisiti per il personale
L'accesso fisico ed elettronico a dispositivi da campo, reti, computer e sistemi deve essere
limitato a un gruppo di persone autorizzate. È quindi necessario utilizzare un sistema di
accesso basato sui ruoli. Definire direttive e procedure dettagliate per consentire l'accesso
al PC o ad altre apparecchiature solo alle persone autorizzate.

2.2  Destinazione d’uso
FieldCare è uno strumento di gestione degli asset di impianto basato su FDT (Field Device
Tool) che, a seconda della versione, può essere utilizzato per la configurazione dei
dispositivi, la gestione degli strumenti o il monitoraggio delle condizioni. Utilizzando i
DTM (Device Type Manager) adeguati, è in grado di gestire dispositivi da campo e
componenti del sistema a prescindere dal protocollo di comunicazione.

È necessario utilizzare un firewall opportunamente configurato che blocchi tutti i dati che
non soddisfano le specifiche di sicurezza. Per aumentare ulteriormente la sicurezza, è
necessario disattivare le porte non utilizzate e implementare una zona smilitarizzata o un
sistema di rilevamento delle intrusioni. Deve essere previsto un processo organizzato di
gestione delle patch in tempo reale per tutti i prodotti, ad es. sistemi operativi, browser
Internet, programmi, app, database e driver. Inoltre, è necessario installare un software
antivirus sul PC. Hardware, software, firmware e altri contenuti elettronici dovrebbero
essere utilizzati solo se provenienti da fonti attendibili.

È consigliabile utilizzare password sicure per l'accesso elettronico ai programmi, ad es. per
PC, FieldCare, server SQL e dispositivi da campo:
• La password deve contenere almeno 8 caratteri
• Non utilizzare nomi utente, nomi personali o nomi di società
• Non deve contenere una parola completa
• Deve differire in modo significativo dalle password precedenti
• Deve contenere lettere maiuscole, lettere minuscole, un numero e un simbolo
• Deve essere modificata regolarmente

2.3  Sicurezza del prodotto
DEP - Data Execution Prevention
DEP è uno strumento di sicurezza che aiuta a salvaguardare i computer da virus, danni e
minacce alla sicurezza. Monitorando i programmi, DEP può contribuire a proteggere i
computer e garantire che le applicazioni utilizzino la memoria del sistema in modo sicuro.
Non appena un'applicazione tenta di accedere a un programma, DEP chiude il programma.

Configurazione di DEP
1. Fare clic su Windows key → Pause key → Advanced system settings → Advanced.

2. Inserire la password di amministratore quando invitati a farlo.

3. Selezionare Performance → Settings.

4. Fare clic sulla scheda Data Execution Prevention e selezionare Turn on DEP for All
Programs and Services. Se il programma non è nell'elenco, fare clic su Add,
selezionare il programma e fare clic su Open.

5. Fare clic su OK.
 Si apre la finestra di dialogo "System properties".

6. Fare clic su OK.

7. Riavviare il computer per attivare le modifiche.
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Numero Spiegazione Stato

0 Sempre Off DEP è disattivo per tutti i processi.

1 Sempre On DEP è attivo per tutti i processi.

2 Inclusione DEP è attivo per i principali programmi e servizi Windows, impostazione predefinita.

3 Esclusione DEP è possibile per tutti i processi, tranne che per programmi e servizi.

Migliorie tecniche
Endress+Hauser si riserva il diritto di eseguire migliorie tecniche a software e dispositivi in
qualsiasi momento e senza preavviso. Se non riguardano il funzionamento del software,
queste modifiche non sono documentate. Se le migliorie hanno effetto sul funzionamento,
viene creata e pubblicata una nuova versione delle istruzioni di funzionamento.

2.4  Sicurezza IT
La garanzia è valida solo se il prodotto è installato e impiegato come descritto nelle
Istruzioni di funzionamento. Il prodotto è dotato di un meccanismo di sicurezza, che
protegge le sue impostazioni da modifiche involontarie.

Delle misure di sicurezza IT, che forniscono una protezione addizionale al prodotto e al
trasferimento dei dati associati, devono essere implementate dagli stessi operatori secondo
i loro standard di sicurezza.
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3  Descrizione del prodotto

3.1  Funzione del software
Queste istruzioni di funzionamento spiegano come FieldCare può essere utilizzato per
stabilire una connessione con dispositivi HART, PROFIBUS, FOUNDATION Fieldbus,
Modbus, IO-Link ed EtherNet/IP utilizzando modem, gateway e moduli I/O remoti.

3.1.1  Sistema di gestione delle licenze software (SLM)
Informazioni dettagliate su "Sistema di gestione delle licenze software (SLM)":
istruzioni di start-up →   7

3.1.2  Ruoli utente
Subito dopo l'installazione, la funzione di login è disabilitata in modo che FieldCare
possa essere avviato senza problemi.

Attivazione della funzione di login
1. Aprire FieldCare Administrator →   14.

2.

Selezionare User and User Groups → Configuration e fare clic su User Login active.

Ruoli utente
Sono disponibili vari ruoli utente. Ogni utente può accedere con il ruolo specifico che gli è
stato assegnato. L'utente riceve l'autorizzazione per determinate funzioni. Ciò garantisce
che solo gli utenti autorizzati abbiano accesso a funzionalità tecniche e operative. Inoltre, i
diritti possono essere definiti per un determinato periodo.

• Creazione di un qualsiasi numero di utenti
• Assegnazione di impostazioni opzionali all'account utente
• Modifica della password in base alle impostazioni opzionali
• Gli utenti possono cambiare una password
• La password utente è valida per un determinato periodo
• Disattivazione dell'account utente se necessario
• Assegnazione di un ruolo all'utente conformemente allo standard FDT

Ruolo utente Diritti di accesso

Amministratore Accesso illimitato a tutte le funzioni, ad es. alle fasi di sviluppo, messa in servizio e
runtime in FieldCare.

Attività di amministrazione, ad es. allocazione degli account utente.

Modifica o aggiornamento del catalogo DTM.

Tecnico di pianificazione Accesso illimitato a tutte le funzioni, ad es. alle fasi di sviluppo, messa in servizio e
runtime in FieldCare.

Tecnico di manutenzione Esecuzione delle fasi di messa in servizio e runtime autorizzate.

Sostituzione, taratura e regolazione dei dispositivi.

Scrittura dei parametri sui dispositivi, modifica o lettura dei parametri.

Esecuzione di operazioni specifiche dei dispositivi in modalità online.

Utente Esecuzione delle fasi di messa in servizio e runtime autorizzate.
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Ruolo utente Diritti di accesso

Osservazione e gestione del processo corrente.

Controllo dello stato attuale di un dispositivo.

Modifica dei setpoint per assicurare che i dispositivi funzionino correttamente.

Osservatore Osservazione e gestione del processo corrente.

Lettura dei parametri dei dispositivi e dei documenti dei dispositivi connessi.

3.2  Applicazione
FieldCare è lo strumento universale per la configurazione e la gestione di dispositivi da
campo intelligenti. Facilita le operazioni di configurazione dei dispositivi, gestione della
manutenzione, manutenzione basata sulle condizioni e gestione del ciclo di vita. Adattabile
alle diverse esigenze tramite licenza e quindi aggiornabile in qualsiasi momento.
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4  Installazione
Informazioni dettagliate su "Installazione": vedere →   7
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5  Funzionamento

5.1  Avviare FieldCare.
‣

Aprire FieldCare.
 Si apre il FieldCare.

5.2  Collegamento di FieldCare al portale W@M.
Requisiti della connessione di FieldCare al portale W@M:
• FieldCare/FieldCare Administration e W@M devono essere installati
• W@M generalmente installato su un server
• FieldCare/FieldCare Administration generalmente installati su un PC
• Conclusione di un contratto per il portale W@M e creazione degli account utente
• Creazione di utenti e password nel portale W@M

5.2.1  Impostazioni in FieldCare.
1. Avviare FieldCare→   13.

2. Chiudere la finestra di dialogo "FieldCare".
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3. Fare clic su Extras → Options.
 Si apre la finestra di dialogo "Options".

4. Fare clic sulla scheda "W@M".
 Viene visualizzata la scheda W@M.

5. Selezionare la casella Enabled e selezionare Serial Number (default).
 I dispositivi vengono identificati in base al numero di serie tra il portale W@M e

FieldCare.

5.2.2  Impostazioni in FieldCare Administration.
Chiudere FieldCare prima di aprire FieldCare Administration.
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1.

Aprire FieldCare Administration.
 Si apre la finestra di dialogo "FieldCare Administrator Login".

2. Inserire Administrator come nome utente, Admin come password e fare clic su
Login.
 Si apre la finestra di dialogo "FieldCare Admin".
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3. Selezionare W@M Configuration.
 Si apre la schermata "W@M Configuration".

4. Selezionare W@M Portal URL e fare clic su Apply.

5. Selezionare l'utente.
 Si apre la schermata "User".

6. Fare clic con il pulsante destro del mouse su Administrator → Properties.
 Si apre la finestra di dialogo "User Properties".
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7. Fare clic sulla scheda W@M.
 Si apre la scheda "W@M".

8. Compilare i campi User Name e Password e fare clic su OK.
 La finestra di dialogo "User Properties" si chiude.

9. Chiudere Windows Explorer.
 La connessione a FieldCare dell'amministratore è stabilita.

Funzioni di W@M
1. Fare clic con il pulsante destro del mouse su un dispositivo.



2. Fare clic su Device in Web → Show device specific details.
 Viene eseguito un test di connettività con W@M.

3. Fare clic con il pulsante destro del mouse su un dispositivo.

4. Fare clic su Documentation.
 Vengono richiamate tutte le funzioni disponibili di W@M.

FieldCare fornisce diverse funzioni per la sincronizzazione dei dati di FieldCare con W@M
Enterprise:
• Upload della configurazione dei parametri offline su W@M
• Upload della configurazione dei parametri online su W@M
• Confronto delle configurazioni dei parametri online e offline
• Confronto delle configurazioni dei parametri offline e storici
• Confronto delle configurazioni dei parametri online e storici
• Confronto delle configurazioni dei parametri storici

5.2.3  Integrazione di Heartbeat Verification nel portale W@M
1. Impostazioni in FieldCare→   13.

2. Impostazioni in FieldCare Administration→   14.
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3. Selezionare W@M Configuration.
 Si apre la finestra di dialogo "Connection".

4. Inserire il numero di contratto W@M e fare clic su Apply.

L'utente riceve un numero di contratto W@M richiedendone uno sul portale W@M.

5.3  Interfaccia utente

 1 Finestra di dialogo principale di FieldCare

1 Vista di impianto
2 Vista di rete
3 Barra dei menu
4 Barra degli strumenti
5 Vista DTM/parametri
6 Finestre di dialogo opzionali
7 Barra di stato

5.4  Impostazioni generali

5.4.1  Impostazioni di progetto
1. In FieldCare, fare clic su Extras → Options.
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2. Fare clic sulla scheda Project.
 Si apre la scheda "Project".

3. Selezionare Prompt for project at start-up e fare clic su OK.
 La finestra di dialogo del progetto viene visualizzata a ogni avvio del programma.

5.4.2  Impostazioni di scansione
1. In FieldCare, fare clic su Extras → Options.

2. Fare clic sulla scheda Scanning.
 Si apre la scheda "Scanning".

3. Spunta la casella accanto a Connect after scanning if only one device is found and
automatically open the DTM in the Online window e fare clic su OK.
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Una volta configurata la rete, viene visualizzato il risultato della scansione.

Dopo la scansione, se FieldCare trova solo un dispositivo, viene stabilita una
connessione automatica con il DTM e commutata online. Se viene trovato più di un
dispositivo, ogni DTM deve essere collegato separatamente. A seconda del DTM, la
connessione può essere avviata anche con un doppio clic su un dispositivo non
collegato. In caso contrario, è necessario utilizzare l'opzione Connect. La
configurazione dei singoli dispositivi non è descritta nelle presenti istruzioni di
funzionamento. Tali informazioni sono reperibili nelle istruzioni di funzionamento del
dispositivo in questione.

Per impostazione predefinita, FieldCare usa le interfacce FDT 1.2 per eseguire una
scansione. Se è abilitata l'opzione "Prefer FDT 1.2.1 scan", in alternativa possono essere
utilizzate le opzioni di scansione FDT 1.2.1.

FDT 1.2.1 può offrire vantaggi in termini di velocità quando si esegue la scansione con
i propri DTM di comunicazione/gateway.

5.4.3  Vista di impianto
Le modifiche alla vista di rete vengono sincronizzate automaticamente con la vista di
impianto. Le modifiche manuali alla vista di impianto non interessano la vista di rete.
È quindi possibile progettare un impianto indipendentemente dalla topologia di rete.

Aggiunta di un nuovo livello
1. Fare clic con il pulsante destro del mouse su un elemento.

2. Fare clic su Plant View → Add Plant Level.
 È possibile selezionare un nuovo livello di impianto.

 2 Struttura della vista di impianto

Livello impianto Descrizione

Enterprise Creare una voce di questo tipo solo nel livello superiore 0.

Site
Area
Process cell
Unit

Creare nel livello 1.

Area
Process cell
Unit

Creare sotto il tipo "Site".

Process cell
Unit

Creare sotto il tipo "Area".
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Livello impianto Descrizione

Unit Creare sotto il tipo "Process cell".

Analysis device
Digital device
Pressure
Special
Flow device
Level
Temperature device
Valve
Unknown device

Creare sotto il tipo "Unit".

Elemento Modificare l'elemento successivamente con Change software.

 Ciò non è più possibile in modo retrospettivo per tutti gli altri tipi. In tal caso, è
necessario cancellare il tipo e crearne uno nuovo.

 Una voce può essere logicamente collegata a un dispositivo nella vista di rete con la funzione Assign.
Cancellare il collegamento usando Unassign Device.
Le didascalie di tutte le voci possono essere modificate successivamente.
È possibile inserire una nota per ogni voce tramite il menu contestuale oppure ogni voce può essere
collegata a un file o a un URL del sito web.

Prima di poter creare la vista di impianto, è necessario creare la vista di rete. La vista di
impianto corrisponde all'effettiva topologia dell'impianto; la vista della tecnologia è una
rappresentazione gerarchica del processo di produzione. Qualsiasi utente con il ruolo di
"Tecnico di pianificazione" o superiore può creare nuove viste di impianto o modificare
quelle esistenti.

Gli elementi possono essere spostati nella vista di impianto. Gli elementi nella vista di
impianto possono essere rinominati, aggiunti o cancellati.

Colonna Uso

Plant TAG Tag impianto per ogni posizione dell'impianto.

Connections Simbolo che indica lo stato online/offline.

Status Indica lo stato diagnostico attuale.

Monitored Opzione per abilitare il monitoraggio del dispositivo attuale tramite Condition Monitoring.

Critical Opzione per specificare se il dispositivo è un dispositivo critico.

Channel Indica il canale tramite il quale è collegato il dispositivo.

Address Indica l'indirizzo del dispositivo assegnato a questa posizione dell'impianto.

Device type (DTM) Indica il tipo di dispositivo.

Physical device Identifica il dispositivo fisico in un determinato punto della rete.

5.4.4  Vista di rete
La vista di rete è una rappresentazione grafica della rete di dispositivi appartenenti a un
progetto FieldCare.

Colonna Uso

Network TAG TAG di rete del dispositivo.

Connections Simbolo che indica lo stato online/offline.

Channel Indica il canale tramite il quale è collegato il dispositivo.

Address Indirizzo di rete univoco del dispositivo.

Device type (DTM) Indica il tipo di ogni singolo dispositivo.

Physical device Identifica il dispositivo fisico in un determinato punto della rete.
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5.5  Funzioni generali
Vista di impianto/rete
• Tramite Context menu → Customize Plant View
• Visualizzazione finestra di dialogo
• Visualizzazione/occultamento colonne
• Regolazione dell'ordine delle colonne

Funzioni elenco
• Ordinamento degli elenchi in base all'intestazione delle colonne
• Modifica della larghezza delle colonne
• Modifica dell'ordine delle colonne con la funzione di "Copia e incolla"

5.6  Verifica della rete
La topologia di rete in FieldCare può essere confrontata con la rete fisica effettiva. Ciò è
particolarmente utile se un dispositivo viene aggiunto a una rete esistente. Un progetto
può essere preparato offline e quindi caricato tramite FieldCare. In questo modo, è
possibile verificare l'attuale topologia nella rete e la topologia fisica per apportare le
modifiche necessarie.

Prima di verificare la rete, tenere conto che vengono verificate solo le reti di dispositivi
di comunicazione che hanno almeno un DTM. In caso diverso, la voce di menu Verify
Network è disabilitata.

Verifica della rete
1. Nella vista di rete, selezionare un dispositivo con almeno un DTM.

2. Fare clic su Verify network  nella barra degli strumenti.
 Si apre la finestra di dialogo "Communication channel".

3. Selezionare il canale desiderato e fare clic su OK.
 FieldCare esegue la scansione del canale desiderato.

Una volta verificata la rete, si apre la finestra di dialogo "Scanning Result".
Viene visualizzata una live list e la colonna Status indica in che misura i
dispositivi nella topologia prepianificata si adattano alla topologia effettiva.
In totale, gli stati sono cinque:
Tipi di dispositivo e numeri di serie identici.
Tipi di dispositivo identici.
Tipi di dispositivo differenti.
Rilevamento di un nuovo dispositivo.
Dispositivo inatteso nel progetto.

4. Le modifiche possono essere apportate nel menu contestuale del dispositivo in
questione. Lettura/scrittura dei dati del dispositivo o sostituzione del tipo di
dispositivo.
Fare clic su OK per confermare le modifiche.
 Le modifiche vengono salvate.
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6  Integrazione di sistema

6.1  Impostazione di un indirizzo IP
• Sono richiesti i diritti di amministratore
• La descrizione si applica a Windows 7

Tutti i dispositivi Endress+Hauser con interfaccia Ethernet vengono forniti con un
indirizzo IP predefinito, ad es. l'indirizzo IP per Fieldgate FXA720 è 192.168.253.1. Perché
il computer host sia in grado di comunicare con il web server Fieldgate FXA720, deve
essere assegnato un indirizzo IP nello stesso dominio di indirizzo, ad es. 192.168.253.99.
Per ulteriori informazioni, contattare l'amministratore di rete.

Impostazione dell'indirizzo IP del computer
1. Fare clic su Start → Control Panel → Network and Internet → Network and

Sharing Center.
 Si apre la finestra di dialogo "Network connections".

2. Fare clic su Manage Network Connections.

3. Fare clic con il pulsante destro del mouse sulle connessioni che devono essere
modificate.

4. Se necessario:
Inserire la Administrator password or confirmation.

5. Fare clic con il pulsante destro del mouse sulla scheda Network.

6. Fare clic su Internet Protocol Version 4 (TCP/IPv4) nella voce "This connection uses
the following items".

7. Fare clic su Properties.

8. Annotare i valori originali dell'indirizzo IP e della maschera di sottorete del computer
per ripristinarli, se necessario, al termine dell'operazione. Un computer utilizzato in
una rete aziendale ottiene il suo indirizzo automaticamente.
Fare clic su Use the following IP addresses.

9. Inserire indirizzo IP, maschera di sottorete e gateway predefinito per "TCP/IPv4".
 Le impostazioni per l'indirizzo IP vengono accettate.

10. Fare clic su OK.
 La procedura è terminata.

6.2  Firewall di Windows
Gli eventuali firewall presenti sui computer su cui risiedono server e client devono
essere programmati per consentire l'accesso reciproco. Dato che la configurazione del
firewall è spesso una questione di politica di sicurezza IT dell'azienda, prima di
procedere è necessario consultare l'amministratore di sistema. Inoltre, per questa
attività sono necessari i diritti di amministrazione.

Le porte disponibili per Fieldgate SFG500 sono elencate nella tabella che segue:

Numero di porta ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT



Integrazione di sistema FieldCare SFE500

24 Endress+Hauser

Gestione del firewall Windows
1. Premere Start → Control Panel → Windows Firewall.
2. Nel riquadro di sinistra, fare clic su Allow a program or feature through Windows

Firewall.
3. Se necessario:

Inserire la Administrator password.

4. Selezionare la casella accanto al programma che dovrebbe essere ammesso e fare clic
su OK.

5. Nel riquadro a sinistra, fare clic su Advanced Settings.

6. Se necessario:
Inserire la Administrator password.

7. Nella finestra di dialogo "Windows Firewall with Advanced Security", fare clic su
Inbound Rules.

8. Nel riquadro a sinistra, fare clic su New Rule.

9. Seguire le istruzioni della procedura guidata New Inbound Rule.

10. Accedere alla scheda Exceptions.
 Si aprono due livelli principali. Le eccezioni possono essere aggiunte su questi

livelli.
"Add Program" specifica quali applicazioni sono in grado di rispondere a richieste
non sollecitate.
"Add Port" specifica che il firewall deve consentire il traffico TCP alle porte
utilizzate dai server.

11. Sulla scheda "General", selezionare la casella On (consigliato).

A questo punto, il firewall è attivo.
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7  Operatività
I dati relativi al progetto vengono salvati in un database o su file, a seconda della modalità
di archiviazione del progetto.

7.1  Impostazione della lingua dell'interfaccia
1. Aprire FieldCare.

2. Fare clic su Extras → Options.
 Si apre la finestra di dialogo "Options".

3. Selezionare la lingua desiderata nella scheda "Display" e fare clic su OK.
 La lingua viene salvata ed è disponibile al successivo avvio del programma.

7.2  Creazione di un progetto
I primi passi della creazione di un progetto sono sempre identici. Per impostazione
predefinita si apre la finestra di dialogo FieldCare; questa impostazione può essere
disattivata accedendo a Extras → Options → Project. La finestra di dialogo FieldCare
non viene più visualizzata se si seleziona la casella None.
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Creazione di un progetto
1. Aprire FieldCare.

 Si apre la finestra di dialogo "FieldCare".

2. Nella scheda "New", selezionare la voce Create Project e fare clic su Open.
 FieldCare apre un nuovo progetto con un PC host.

7.3  Salvataggio di un progetto
I progetti FieldCare sono memorizzati in un database ma non sono accessibili come
file sul disco rigido. È possibile accedere a questi file utilizzando FieldCare in modalità
file. Tutti i progetti vengono salvati nello stesso modo.

Salvataggio di un progetto
1. Selezionare File → Save As.

 Si apre la finestra di dialogo Save Project As.

2. Inserire il nome del progetto e fare clic su Save.
 Il progetto viene salvato.
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7.4  Apertura di un progetto salvato
Apertura di un progetto salvato
1. Nella finestra di dialogo FieldCare, fare clic sulla scheda Existing.

 Si apre la finestra di dialogo "Open Project". Vengono visualizzati gli ultimi
progetti da aprire.

2. Selezionare Project e fare clic su Open.
 Il progetto viene visualizzato.

Se il progetto non viene visualizzato, fare clic su View → Network.

7.5  Esportazione e importazione di CSV
Le informazioni strutturali della vista di impianto e di rete (topologia impianto/rete)
possono essere esportate in un file CSV e importate da un file CSV in un progetto
FieldCare.

Importazione di un file CSV
1. Creare un progetto. →   25

2. Fare clic su File → Import/Export → Import CSV file.
 Si apre la finestra di dialogo "Import CSV file".

3. Selezionare un file e fare clic su Open.
 I dati del file CSV vengono importati nella vista di impianto e/o nella vista di rete.

Esportazione di un file CSV
1. Selezionare un progetto.

2. Fare clic su File → Import/Export → Export CSV file.
 Si apre la finestra di dialogo "Exported topology".

3. Fare clic su Export.

4. Selezionare una posizione di archiviazione e un nome e fare clic su Save.
 La vista di rete viene esportata in un file CSV.

7.6  Informazioni sui DTM
La finestra di dialogo Information contiene un sommario di tutte le principali
informazioni sui DTM.
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Visualizzazione delle informazioni sui DTM
1. Fare clic su Device catalog nella barra dei menu.

2. Fare clic su Display.
 Si apre il catalogo del dispositivo.

3. Fare clic con il pulsante destro del mouse su un DTM.

4. Fare clic su DTM Information.
 Si apre la finestra di dialogo "Information".

Opzioni contenute nella finestra di dialogo "Information"
• Mostra le informazioni di base di tutti i tipi di dispositivi supportati da DTM
• Visualizza informazioni sui DTM:

• ID del produttore
• ID tipo di dispositivo
• ID tipo di sottodispositivo
• Informazioni sul tipo di dispositivo

7.7  Visualizzazione del catalogo del dispositivo
La finestra di dialogo Device catalog contiene l'elenco di tutti i DTM e FDI Package
attualmente presenti nel sistema di gestione dispositivi. I DTM possono essere raggruppati
per categoria, produttore o protocollo.

1. Fare clic su Device catalog nella barra dei menu.

2. Fare clic su Display.
 Si apre il catalogo del dispositivo.

7.8  Aggiornamento del catalogo del dispositivo
Informazioni dettagliate su Aggiornamento del catalogo del dispositivo: Guida
introduttiva →   7
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8  Diagnostica e ricerca guasti

8.1  Ricerca guasti generale

Problema Ricerca guasti

Il server SQL FieldCare
non si avvia.

Avviare il server SQL manualmente:
• Aprire Windows e inserire services.msc nel campo di ricerca.
• Selezionare SQL Server (SQLFIELDCARE).
• Fare clic su Start.

Macro di scansione
mancanti.

Importare le macro:
• Nella cartella "...\Endress+Hauser\FieldCare\db" importare il file

ImportScanningMacros.cmd.
• Quindi riavviare FieldCare.

Voci di menu duplicate
o finestre mancanti.

Resettare il layout:
• Chiudere FieldCare.
• Nella cartella "...\Endress+Hauser\FieldCare\Profiles", cancellare il file profile.xml.

Catalogo dispositivo
difettoso.

Resettare il catalogo dispositivo FieldCare:
• Chiudere FieldCare.
• Nella cartella "...\Endress+Hauser\FieldCare\Frame", cancellare il file

FRMRepository.xml.
• Riavviare FieldCare e aggiornare il catalogo dispositivo.

In caso di ulteriori problemi, contattare il centro vendite Endress+Hauser:
www.addresses.endress.com
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9  Aggiornamenti software
Informazioni dettagliate su "Aggiornamento software": vedere →   7





www.addresses.endress.com

*71600085*
71600085
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